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General

Foreword

This manual introduces the functions and operations of the ConfigTool (hereinafter referred to as
"the Tool"). Read carefully before using the tool, and keep the manual safe for future reference.

Safety Instructions

The following signal words might appear in the manual.

Signal Words

Meaning

A DANGER

Indicates a high potential hazard which, if not avoided, will result in
death or serious injury.

A WARNING

Indicates a medium or low potential hazard which, if not avoided,
could result in slight or moderate injury.

A CAUTION

Indicates a potential risk which, if not avoided, could result in
property damage, data loss, reductions in performance, or
unpredictable results.

Provides methods to help you solve a problem or save time.

Provides additional information as a supplement to the text.

Revision History

Version Revision Content Release Time
® Added Encoding Strategy.
® Added Average Bit Rate (ABR).
® Added the encryption and decryption
V1.2.6 function when exporting and importing January 2024
configurations.
® Added VTS/VTO/VTH configurations in the
download template.
V1.2.5 Added the LLDP function. November 2023
® Added the configuration file import
function.
V1.24 ® Added configuration search function. October 2023
® Updated the building configuration
function.




Version

Revision Content

Release Time

V1.2.3

Updated Modify IP page.

Updated device configuration function.
Updated system configuration function.
Added file upgrade function.

Added intranet and extranet online
upgrade function.

Updated Building Configuration page.

January 2023

V1.2.2

Updated the installation function.
Added online upgrade function.
Updated password reset function.
Updated building configuration page.
Updated system configuration function.
Updated tool setting function.

July 2022

V1.2.1

Deleted online upgrade function.

April 2022

V1.2.0

Updated home page.

Added online upgrade function.
Updated functions in adding devices.
Updated functions in configuring video
device parameters.

Updated functions in resetting device
password.

January 2022

V1.1.7

Added join user experience improvement
program" and privacy policy.

Updated access control devices function.
Added alarm host devices function.

Update pictures in building configuration.
Updated configuring parameters function.

May 2021

V1.1.6

Updated functions in building configuration.

February 2021

V1.1.5

Updated functions in building configuration.

January 2021

V1.1.4

® Added installation and uninstallation
function, VDP function, android digital
function and building configuration
function.

® Updated pictures in the manual.

® Updated configuring ACS parameters
function and CGl protocol.

September 2020

V1.1.3

® Added batch config items.
® Updated user page.
® Added to support ACS devices.

June 2020

V1.1.0

Added upgrade transmission speed.

March 2020

V1.0.7

® Added help section.
® Deleted online upgrade function.

September 2019

V1.0.6

Updated resetting device password function.

July 2019




Version Revision Content Release Time

® Updated configuring system settings
function.

® Changed the notice box in upgrade

V1.0.5 function and online upgrade function. March 2019

® Updated the template management page,
and updated configuring video device
parameters function.

® Added a notice box when you click reset
password in the reset password menu.

® Added a notice box when click batch

V1.04 download and upgrade detect in the online | April 2018
upgrade menu.

® Added the function to get back video
password in the system settings menu.

Added cybersecurity recommendations and

V1.0.3 - . September 2017
online upgrade section.
V1.0.2 Modified the basic operations section. March 2017
® Added the description of uninstallation.
V1.0.1 N 201
0 ® Modified the basic operations section. ovember 2016
V1.0.0 First release. February 2016

Privacy Protection Notice

As the device user or data controller, you might collect the personal data of others such as their
face, fingerprints, and license plate number. You need to be in compliance with your local privacy
protection laws and regulations to protect the legitimate rights and interests of other people by
implementing measures which include but are not limited: Providing clear and visible identification
to inform people of the existence of the surveillance area and provide required contact information.

About the Manual

® The manual is for reference only. Slight differences might be found between the manual and the
product.

® \We are not liable for losses incurred due to operating the product in ways that are not in
compliance with the manual.

® The manual will be updated according to the latest laws and regulations of related jurisdictions.
For detailed information, see the paper user’s manual, use our CD-ROM, scan the QR code or
visit our official website. The manual is for reference only. Slight differences might be found
between the electronic version and the paper version.

® All designs and software are subject to change without prior written notice. Product updates
might result in some differences appearing between the actual product and the manual. Please
contact customer service for the latest program and supplementary documentation.

® There might be errors in the print or deviations in the description of the functions, operations
and technical data. If there is any doubt or dispute, we reserve the right of final explanation.

® Upgrade the reader software or try other mainstream reader software if the manual (in PDF
format) cannot be opened.

® All trademarks, registered trademarks and company names in the manual are properties of their
respective owners.




® Please visit our website, contact the supplier or customer service if any problems occur while
using the device.

® |f there is any uncertainty or controversy, we reserve the right of final explanation.
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1 Overview

The Tool provides the following functions to configure and maintain devices such as IPC, NVR,
access controller and video intercom:

® |nitialize the device.

® Change device IP.

® Upgrade the device.

® (Configure video parameters, encoding parameters and profile mode; Configure access
controller (card number byte revert of different channels, TCP port number, log, and more);
Configure VDP (device details, physical information, and Sip server information); Configure
Android digital signage (APP configuration, Android commission, and log exporting).
Synchronize device time, restart device, restore system default, modify device password, reset
password and perform batch configuration.

Configure VTO and VTH information.

Configure device information in batches through CGl commands or tables.

B

Do not use the Tool with Device Diagnostic Tool, SmartPSS (Smart Professional Surveillance System)
or DSS (Digital Surveillance System) at the same time; otherwise it might cause device search
exceptions.




2 Installation and Uninstallation

This chapter introduces how to install and uninstall the Tool.

2.1 Installation

Make sure that you have the installation package of the Tool; if not, contact customer service.
Procedure

Step1  Double-click the installation package, and then the Tool pops up the Installer Language
dialog box.

Figure 2-1 Install language

Installer Language @

@ Please select the language of the installer

Engish |

K, Cancel |

Step2  Select English as the installer language, and then click OK.

Figure 2-2 Welcome

Config Tool

| Hext (H] || Cancel (C) |

Step3  Click Next.




Step4 Read the software license agreement, select | agree, and then click Browse to select save
path.

Step5 Click Install.
Figure 2-3 Install

IMSTALLATION IS COMPLETE!

|Er|.j-:-3r Fow (E] | | Close ([C) |
Step6 Click Enjoy Now to complete the installation and start the Tool, or click Close to exit.
Step7 Read software license agreement and Config Tool privacy policy, select | have read and
accepted , and then click Agree and continue.
Step8 Click Agree to join user experience improvement program.

[

Click Privacy Policy to view the specific content.

Figure 2-4 Join user experience improvement program

Join User Experience Improvement Program

Help us improve our software and human-computer interaction
technology by joining our User Experience Improvement Pragram.
Through the program, we will collect recards on your feature usage,
which will not be used to personally identify you. We will use the
collected information to analyze software function usage and
improve the functions and performance.

Privacy Policy Disagree




2.2 Uninstallation

Procedure

Step1  Click Start > All Programs > ConfigTool > Uninstall ConfigTool on your computer
(uses Windows 7 as an example).

Figure 2-5 Uninstall

Config Tool

[Uninstall (01 | | Caneel () |

Step2 Click Uninstall to uninstall the Tool.
After the uninstallation is completed, the Prompt page will be displayed.
Figure 2-6 Prompt

Prompt

This program has been successfully uninstalled.

Step3  Click OK to complete the uninstallation.




3 Home Page

After starting the Tool, the home page is displayed.
(11

® After starting the Tool, the Tool searches devices according to the network segments set in
Search setting.
® Current Segment Search checkbox is selected by default.

Figure 3-1 Home page

1D configtool 9 <

El  ModityiPs

Batch Moty IP Import Expont Manual Add Delate

= WO, State Type Modei IPORT MAC WVersion Operate
1 Initialized Ve WINGoWs 10 13 L 86 V7.0 Edit
2 Initialized PC 2430 10 i 14 Zb:0b  V2BE0.0000 Edit Data
L] Initialized VTH 10 rr fc d0c V47000000 Edit
& Initialized NTO G 10 T 14 Mag  v4.600.0000 Edit
5 Initialized VTO G-P 10 m 14 #0686 V4400980 Edit etadl:
] Initialized VTO 2F-P-52 10 i fc d54  V4.600.0000 Edit
T Initiglized WTH 1 T 1c c52 V47000000 Edit
B Initialized VTO P52 10 S fe dSd4 V46000000, Edit
] Initialized NTO 1G-P |l T L) #1:3b  V4.511.0000 Edit
You have select 0 device(s). [ ] Unilnit (] Init PV4 PVE

Table 3-1 Home page description

No. Function Description

1 - Displays searched devices.

Click © to refresh the device list that is displayed in the
main page.
an|

After opening the Tool, if the username or password has

2 Refresh not been changed, every time you click <, a notice box

will pop up prompting you to go to Search Setting to
change your username or password. Select Don't
prompt again and the notice box will no longer be
displayed.




No.

Function

Description

Search setting

You can search the devices within the current network
segment or other network segments.

Help

Click ¥ to check the Help file, software license, software
version and related parameters.

Main page

® |[nitialize : Select one or multiple devices to start
initializing them.

® Batch Modify IP : Select multiple devices to modify
their IP addresses.

® |mport: Import one or multiple devices through
template.

® Export: Select one or multiple devices to export
device details.

® Manual Add : Add a device by entering device details
such as IP address, type, username, password and
port.

® Delete: Select one or multiple devices to remove
from the list.

Functions

® Modify IP : Modify IP address of one device or
multiple devices.

® Device Upgrade : Upgrade device versions.

® Device Config : Configure encoding, image, and
profile management.

® System Settings : Set device system time, restart
device, restore device, modify password and reset
password.

® Password Reset : Reset password through the QR
code and XML file.

® Building Config : Add building organization nodes,
link building devices and synchronize configurations.

® CGI Protocol : Configure device information in
batches through CGl commands or tables.




4 Basic Operations

4.1 Adding Devices
You can add one or more devices.

Make sure that the device is in the same network segment with the PC installed with the Tool;
otherwise the Tool cannot find the device.

4.1.1 Adding One Device

4.1.1.1 Adding by IP Address

Procedure

Step1 Click EBEEEA 2nd then select Manual Add > IP Address.
Step2  Configure manual add parameters, and then click OK.

Figure 4-1 Manual add (IP address)

Manual Add e

IP Address

Username admin
Password sssssses
Port

Table 4-1 Description of manual add parameters

Parameter Description
IP Address The IP address of the device.
Username
The username and password for device login.
Password
Port The device port number.

Step3  Click OK.

The newly added device is in the device list.




4.1.1.2 Adding by Registering

Under the internal and external network scenario, if ConfigTool cannot be directly connected to the
device but the device can access the computer where ConfigTool is located, you can obtain and
deliver device configurations through registering.

Procedure

Step1 Click EBEEE :nd then select Manual Add > Register.

Step2 Enterthe Server IP and Server Port, and then click next to the Server to enable
registering function.

Figure 4-2 Configure the Server

Register

configure server Import Manage Devices
Server
Server IP
Server Port 9500

Step3  Click the Import tab, and then click Download to download the registering template.




Figure 4-3 Download the template

Reqgister

configure server Import Manage Devices

Download

Step4  Enter the device registration information in the downloaded excel file, and then click 0
to import the device.

[

® Supports adding multiple devices.

® The imported devices can be viewed on the Manage Devices page.
Step5 Click Manage Devices tab to view the imported devices.

L]

® The IP and Port columns display the IP and port numbers of the device.

® The devices whose status is Synced are automatically added to the device list on the
Modify IP page.




Figure 4-4 Manage the Device

Register

configure server Import Manage Devices

D NO. Device ID Port P Status
[ | 1 test122 ]

1 2 test197 .

O 3 test200

Table 4-2 Description of status parameters

Status Whether the device is Whether the device is added to
registered to the ConfigTool the Modify IP page

Synced Yes Yes

Not Synced Yes No

Offline No No

Step6  (Optional) Select the device that is not synced, and then click Sync to add the device to
the device list on the Modify IP page and the status of the device switches to Synced.

4.1.2 Adding Multiple Devices

You can add multiple devices through searching devices or importing the template.
4.1.2.1 Adding by Searching

You can add multiple devices by searching in the current segment or other segment.
Background Information

L1

You can set filtering conditions to search specified devices quickly.

Procedure
Step1  Click Search Setting.

10



Figure 4-5 Setting

B current Segment Search || Other Segment Search

Username admin Password ~ sssss

Step2  Select search method.

® Current Segment Search : Select the Current Segment Search checkbox. Enter the
username in the Username box and the password in the Password box. The system
will search devices accordingly. Current Segment Search is selected by default.

® Other Segment Search : Select the Other Segment Search checkbox. Enter IP
address in the Start IP box and End IP box respectively. Enter username and
password. The system will search the devices accordingly.

(1

If you select both the Current Segment Search checkbox and the Other Segment
Search checkbox, the system searches devices under both conditions.

® Use the login username and password when you want to modify IP, configure the
system, update the device, restart the device, and other operations.

® Supports searching up to 16 network segments simultaneously.
Step3  Click OK.

Results will appear in the device list on the main user page.

1]

® Click < to refresh the device list.

® The system saves the search conditions when exiting the software, and reuses the
same conditions when the software is launched again.

4.1.2.2 Adding by Importing Device Template
You can add devices by filling in and importing an Excel template. You can import 1000 devices at
most.

Background Information

(L1

Close the template file before importing devices; otherwise the import will fail.

Procedure

Step1  Click skl sclect one device, click Export, and then follow the on-screen guide to
save template file locally.

Step2 Open the template file, and then fill in the information of devices to be added.
Step3  Click Import, select the template, and then click Open.

11



The system imports the device details. After the import completes, a success prompt will
be displayed.

Step4  Click OK.

The newly imported devices appear in the device list.
4.2 Initializing Devices

You can initialize one or multiple devices.
Background Information

® This function is available on select models.

® The initializing operation can only be performed to the devices within the local area network.
® Any operation cannot be performed on uninitialized devices.

Procedure
Step1  Click ENNEERE
Step2  Select devices to be initialized, and then click Initialize.

Figure 4-6 Device initialization (1)

Device initialization

1 device(s) have not been initialized

H NO. Type Model IP MAC Version

B IPC IPC T-A... NEE ]

Initialize

Step3  Configure initialization parameters, and then click Next.

12



Figure 4-7 Device initialization (2)

Device initialization

1 device(s) have not been initialized

Username admin
Mew Password (Tl
Weak - Strong
Confirm Password Tl

EmailAddress  1****g@gmail.comR

Select PiM PAL -

Mext

L1

® [f you do not provide the email address for password reset, you can only reset the
password through XML file.

® When initializing multiple devices, the Tool initializes all devices based on the
password reset mode of the first selected device.

Table 4-3 Initialization parameters

Parameter Description

Username The user name is admin by default.

Enter your new password. A prompt appears to inform you the
strength of your new password.

New Password
[

The password strength might vary depending on the devices.

Confirm Password Confirm the new password.

It is selected by default.

Email Address
The email address is used for password reset.

Step4  Select Easy4ip or select Auto-check for updates, and then click OK. If neither is needed,
leave them unselected.

13



L1

Some devices do not support automatic detection and Easy4ip.

Figure 4-8 Device initialization (3)

Device initialization

Easydip

Register device to EASY4IP and then suitable for user to apply for cloud account. It
can realize cloud service such as remote surveillance, device record, alarm, cloud
storage, using device to manage cloud.

Auto-check for updates

Motify automatically when updates available. The system checks for updates every day.

Online Upgrade is a semvice that provides you with firmware updates by cloud. This
senvice will collect device information in order to inform you about available firmware
updates. Such information may include your device name, firmware version and device
identification numbers. Such information is processed for the sole purpose of informing
you about firmware updates.

Step5 Click the success icon () or click the failure icon (#+) for details.

Figure 4-9 Initialization

Initialization

1 device(s) have been activated!

NO. Type Model IP MAC Version

1 “  IPC IPC-H WS- 1%gr = V2 ER i "n

Step6  Click Finish.

After initialization is completed, the status of the devices shows as Initialized on the
main page of the Tool. The devices also appear on other pages of the Tool.

14



4.3 Modifying IP

You can modify IP for one or more devices at a time.

You can modify IP in batches only if the login passwords for all the devices are the same; otherwise
you can only modify one IP at a time.

4.3.1 Modifying One IP

Procedure

Step 1
Step 2

Step 4

Click ENEEER
Select the device for which you want to modify IP, and then click Edit.
[

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Figure 4-10 Modify IP address

Modify IP Address

Mode @  static () DHCP
TargetIP
Subnet Mask

Gateway

Selected number of devices: 1

Configure IP address.

® DHCP mode: If the DHCP server is available in the network, when you select DHCP,
the device will automatically obtain the IP address from the DHCP server.

® Static mode : When you select Static, you need to enter Target IP, Subnet Mask, and
Gateway. The IP address of the device will be changed to the one you set.

Click OK.

4.3.2 Modifying IP in Batches

Procedure

Step 3

Click [E  Modify IP i
Select the devices for which you want to modify IP.

L1

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Click Batch Modify IP.

15



Figure 4-11 Modify IP address (3)

Modify IP Address

Mode @®  Static
Start IP [] samelp

Subnet Mask

Gateway

Selected number of devices: 2

Step4  Configure IP address.

® DHCP mode: If the DHCP server is available in the network, when you select DHCP,
the device will automatically obtain the IP address from the DHCP server.

® Static mode: When you select Static, you need to enter Start IP, Subnet Mask, and
Gateway. The IP addresses of the devices will be modified successively starting from
the first IP entered.

L1

If you select the Same IP checkbox, the IP address of the devices will be set to the same
one.

Step5 Click OK.

4.4 Upgrading Devices

Supports upgrading device separately or in batches, and upgrading through files.
Upgrade speed varies depending on the package size.

® |f package < 100 MB, the Tool loads the package 1 KB every time. The speed cannot be modified.

® |f package size = 200 MB, the Tool loads the package at 16 KB every time. The speed cannot be
modified.

® |f 100 MB < package size < 2 GB, the Tool loads the package 1 KB every time. To speed up the
process, you can set the speed to 16 KB every time. For details, see "5.3 Settings".

L1

If the device disconnects during update, the device might restart and automatically tries to update

again.

® |f the system notices Upgraded successfully, search the devices again and the devices with
upgraded versions show up.

® |f the system notices Wait for retry, wait for 1 - 2 minutes and then retry.

® |f the system notices Upgrade overtime or Failed to upgrade, search the device and upgrade
again.

16



4.4.1 General Upgrade
4.4.1.1 Upgrading One Device

Procedure

Step1  Click
Figure 4-12 Upgrade

Batch Upgrade Search

] no. Model P Version Upgrade File Path Operate
(I VT am 5 [1]
0 =2 VT 5 [1]

Step2  Click =) next to the device that you want to upgrade. Select the specific file that needs to
be upgraded, and then click Open.

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Step3  Click [l to start upgrading.

After upgrade is complete, a Prompt dialog box will be displayed indicating the device
will be restarted, and then the device restarts automatically.

4.4.1.2 Upgrading Devices in Batches

You can upgrade multiple devices in the same software version.
Procedure

Step1  Click
Step2  Select the devices that need to be upgraded.

L1

® [f the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".
® Make sure all selected devices can receive the same software update.

17



Figure 4-13 Batch upgrade

Batch Upagrade

pgrade File Path:

Selected number of devices: 1 OK

Step3  Click Batch Upgrade.
Step4  Click Browse to select the files that need to be upgraded.
Step5 Click OK.

4.4.2 File Upgrade

Procedure
Step1 Click
Step2 Click - on the lower-right corner of the page to switch to file upgrade mode.
Step3 Click Open Template, and then enter the IP address, port, username, password and
upgrade file path of the device.
Step4  Click Import to import the filled template.

18



Figure 4-14 File upgrade

100 c Search Setting x

NO. Import Path Upgrade
1 D-/pythonftest_1.xsx B [
2 Dipythonftest_2.xsx B [l
3 D:/pythonftest_3 xisx B [
4 Di/pythonftest_4 xisx B [
5 Dipythonftest_5.xisx D [
6 D:ipythonftest_6xisx B (2]
7 Dipythonftest_7 xisx Ay [#]
8 Dfpythonftest_8 xisx B [
[] 9 Di/pythonftest_9.xisx D [
) 10 DeJpythonftest_10.xsx B [
You have selected 13 file(s) I~

Step5 Upgrade the device.

The upgrading steps of the file upgrade mode is consistent with the general mode. For
details, see "4.4.1 General Upgrade".

4.5 Online Upgrade

4.5.1 Detecting Devices

Prerequisites

Make sure that the PC where ConfigTool is installed is connected to the Internet.
Procedure

Step 1 Click CNEEE

19



Figure 4-15 Online upgrade page
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Step2 Enter the Activation Code, and then click Activate.
11

Inactive users cannot perform online upgrade operations. The activation code needs to
be applied for from the service provider.
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Figure 4-16 Online upgrade page after activation

38 Device(s) foun e Search Setting X

Batch Check Batch Upgrade Export Upgrade Info [ View Upgrade Info Search e}

3, D NO. IP:Port Upgrade Result Upgradeable Check Upgrade

T ¥
-
-
"
n

=gooo=

T3
a1

" .

ooo®

17 5
"
1
n

3
1
L |

AECECEEEEE
" a-
{5k

e

|

n

OO0O0O0O0O0OO0O0O0O0O00O000000ono

JmOoo
-
.

You have selected 0 device(s) Download line | Line1 -

Step3  Select the model to be operated on the left side of the page, and then the corresponding
device information will be displayed in the device list.

Multiple devices of the different models can be upgraded in batches at one time.
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Figure 4-17 Select online upgrade devices
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You have selected 0 device(s) Download line | Line1 =

Step4 Click Check corresponding to the device or select the devices to be checked, and then
click Batch Check to check whether there is a new upgrade program.

® |f the device is upgradable, the Upgradeable column displays yes and the Upgrade
Result column is empty.
® |f the device is not upgradable, the Upgradable column displays no.

® |f the check fails, click “* to view the failure reason.

22



38

~y
L

Figure 4-18 Check upgrade status
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(Optional) When the device checks multiple upgradeable programs at the same time, if
the detection is successful, the upgradeable column displays Unknown . Point to
Unknown to display specific prompts.

Step 5

Figure 4-19 Check multiple upgradeable programs

NO. IP:Port Upgrade Result Upgradeable Check Upgrade

Check

(1]

Build date or Latest version check fai|edi

i = S Unknown

4.5.2 Online Upgrading Devices

Prerequisites

® The online upgrade function has been activated. For details, see "4.5.1 Detecting Devices".

® All devices that need to be upgraded have successfully completed the checking, and those that
have not been checked or failed to be checked will not be added to the upgrade queue.

Procedure
Step1  Click [Zl corresponding to the device, or select the devices to be upgraded, and then click
Batch Upgrade.
[L]

The upgrade result displays only the latest upgrade result. If the upgrade succeeds, the
Upgrade Result displays as Success; if the upgrade fails, the Upgrade Result displays as
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Fail. If there is no upgrade record or the last upgrade is more than 3 months old, nothing
is displayed.

Step2 (Optional) If the device detects multiple upgradeable programs at the same time, select
the Upgrade File Name and Type, and then click OK.

Figure 4-20 Select upgrade package

Upgrade package confirmed

\_I NO. P SN Upgrade File Name Type
] 1 1i | e [l | - - 1.001.0(~ | Main Program v
I : - I m
- i & _=8300.00...

The above devices have detected multiple packages, please select a specific upgrade package and upgrade type in the drop-down box.
“

Step3  After clicking Batch Upgrade, you need to confirm whether key information such as the
device OSD and third-party access configuration is lost before the upgrade of the first
device. After confirmation, click OK.
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53

Figure 4-21 Confirm ODS information
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Batch Check Batch Upgrade Export Upgrade info [ View Upgrade Info Search S
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- Notice Upgrade
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-I = |Che l_}
Please confirm whether the OSD 5
B : : |Check -
= = 2 information is correct. (2]
. (Check +
@
=
— [Check IT_]
=

= o - {Check [-]
: | T N 7 TES -'Check m

n s 2 u »
. B s Sheck =
v B s - yes o [z]

- i
& B - = yes Check [%]

- - g
" B o = yes Check [2]

L B ]
You have selected 15 device(s) Upgrade progress @ 8%

After the OSD information is confirmed, the Tool collects online rates for all devices in the
remaining task queue.

The Tool first upgrades 20% of the remaining devices, waits for 3 minutes when the last
device of the 20% is upgraded, and then checks whether the 20% of the devices can log
in normally. If the online rate exceeds 90%, the remaining 80% of the devices will be
upgraded directly. If the online rate is lower than 90%, a pop-up dialog will prompt that
the remaining 80% of devices cannot start normally. Click OK to continue upgrading the
remaining devices, otherwise all the subsequent upgrades will be cancelled.
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Figure 4-22 Collect online rate
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Batch Check Batch Upgrade Export Upgrade info @ View Upgrade Info
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You have selected 15 device(s)

Upgrade progress @

8%

4.5.3 Exporting and Viewing the Upgrade Result

® (lick Export Info to export the upgrade result to the computer.
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Figure 4-23 Export upgrade result
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File name: |Upgrade information
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3.
0.
A
You have selected 0 device(s) Download line | Line1 =~

® (lick View Info to view the exported .dat file.

Figure 4-24 View upgrade result
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4.5.4 Intranet and Extranet Online Upgrade

Procedure

Step 1

Click Intranet Export to export device information.

® After clicking Intranet Export, all devices in the device list will be exported. If there
are any devices that do not need to be upgraded, you can delete them on the Modify
IP page.

® Make sure the account password is correct.

Figure 4-25 Intranet and extranet online upgrade

S Search Setting X

Batch Check Batch Upgrade Export Upgrade Info [l View Upgrade Info Search -

ood

Step 2

Step 3

Intranet Export

= 1 [] No. IP:Port Upgrade Resu Check Upgrade
Extranet Import

Extranet Export

Infranet Import

You have selected 0 device(s) Download line | Line1 =

Copy the exported file to the computer that can be connected to the Internet, click
Extranet Import, and then select the file.

[

After the import is successful, the Tool automatically starts to detect and download the
upgrade package, and the download directory of the upgrade package can be selected
and viewed through > Setting on the upper right corner of the Tool.

Click Extranet Export to copy the exported dat file and the upgrade package to the
intranet computer.

The upgrade package must be stored in the default download path of the Intranet
computer. Otherwise, the upgrade will fail.

Click Intranet Import on the intranet computer, select the exported dat file and the
device to be upgraded, and then click Upgrade or Batch Upgrade.
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4.6 Configuring Device Parameters

Configure device parameters such as encoding, video and profile.

4.6.1 Accessing the Configuration Page

Procedure
Step1 Click &l .
Step2  Select the device in the device list, and then click Get Device Info or double-click the

device.
11

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Step3  (Optional) If the login dialog box is displayed, enter your username and password, and
then Click OK.

® Foranencoder, the Encode page is displayed.
® Foran ACS device, the ACS Config page is displayed.

4.6.2 Configuring Video Device Parameters

You can configure device parameters such as the encoding, video and profile.

[

The page and parameters might vary depending on the device type and model.
4.6.2.1 Configuring Encoding Parameters

You can configure parameters such as code stream type, compression and resolution of the device.
Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2 Onthe Encode page, configure the parameters for main stream and sub stream.
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Figure 4-26 Encode

Channel

Main Stream

Code Stream Type Regular - Compression H.264H -
Encoding Strateqgy Regular - Audio
Bit Rate Type CEBR - _ ’
Audio Encode GITA -
Frame Rate ﬂ 25
Sampling Frequency 3000 -
Resolution QFHD -
Quality I 4
Bit Rate(kKb/S) Customized - 3328
Sub Stream
Code Stream Type Regular - Compression H.264H -
Bit Rate Type CBR - .
¥ Audiolideo ]
Apply to...
11

The encoding parameters might vary with different models.

Table 4-4 Encode parameters

Parameter Description
Channel Select channel number.
Code Stream Type Includes Regular , Motion, and Alarm. The sub stream only supports

Regular type.

Encoding Strategy

Includes Regular, Smart Codec, and Al Codec. Only the main stream
can configure this parameter.

Compression

Includes the following video encoding modes:

® H.264: main profile encoding.

® H.264B: baseline profile encoding.

® H.264H: high profile encoding.

® H.265: main profile encoding.

® MJPG: Under this mode, the video image requires a higher bit rate
to ensure video quality. We recommend you use the maximum bit
rate value to get the best results.

® SVAC2.0: SVAC2.0 encoding.
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Parameter Description
Includes the two types of bit rates:
® Constant Bit Rate (CBR) : The bit rate is fluctuating around the set
value without changing significantly.
® Variable Bit Rate (VBR) : The bit rate changes along with the
Bit Rate Type monitored environment.
® Average Bit Rate (ABR) : The bit rate is controlled to save
bandwidth and improve image quality.
[0
When the compression is set as MJPG, the bit rate can only be CBR.
Total frames per second.
Frame Rate
The higher the frame rate, the more clear and smooth the image.
Video resolution.
Resolution The maximum video resolution might be different depending on your
device model.
Video image quality level.
Quiality
You can configure this parameter when the bit rate type is set as VBR.
Select a suitable value.
Bit Rate (Kb/S) 1
You can configure this parameter when the bit rate type is set as CBR.
® Select the Audio checkbox to enable audio function.
® Select the Video checkbox to monitor with sub stream.
For the sub stream, you can enable the audio function only after the
video function is already enabled.
Audio/Video
[0
In the Sub Stream section, the two checkboxes next to Audio/Video
stand for audio and video respectively. To enable audio, select the first
checkbox; for video, select the second one.
Audio encoding modes includes G.711A, G.711Mu, G.726 and AAC.
Audio Encode The setting of audio encoding mode will apply to both audio and voice
intercom.
Sampling Frequency The sampling frequency of the audio.

Step3 Click OK to complete settings.
Step4  (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon () will be displayed.

2. Click Return to return to the configuration page.
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4.6.2.2 Configuring Video Parameters

You can check the live video and set video effects.
Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2 Click the Image tab.
1]

® (lick Default to restore the default parameters settings.

® Roll mouse wheel on the image to zoom in or zoom out. Right-click on the image to
return to default size.

® On theimage, click B to display in full screen, and then click EH on full screen to
restore the default.

Figure 4-27 Image

| Profile Day il
Channel 1 -
Color Mode

| @ stancara O right O sot
Brightness _E'| 58
Contrast % 50
Gamma _E| 50

Saturation sl 27
| zoom e °
Easy Focus Default DayMight Mode
Color @ Auto BW
BLC Mode OFF -

Channel Name IPC

Apply to...

Step3  Configure the video parameters.

Table 4-5 Video parameters

Parameter Description

Profile Select the device profile from Day, Night, and Normal.

Channel Select channel number.

Color Mode Select image color mode from Standard , Bright, and Soft.

Brightness Adjust image brightness. The bigger the value, the brighter the image.

Adjust image contrast. The bigger the value, the more obvious the

Contrast contrast between the light and dark areas.

Adjust image brightness in a non-linear way to improve the dynamic

Gamma display range. The bigger the value, the brighter the image.
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Parameter

Description

Saturation

Adjust color. The bigger the value, the lighter the color. This value
does not affect the general image lightness.

Zoom

Click o or ° to adjust the zoom speed.

L1

This function is available on select models.

Day/Night Mode

Includes the following three options:

® (olor: Select this option to set image color.

® Auto: Select this option to automatically set the image to be one of
the other two options according to the environment.

® BW: Black and white. Select this option to set image to be black
and white.

BLC Mode

® OFF: Turn off the backlight compensation mode.

® BLC: Backlight compensation. In environments with strong
backlighting, the compensation function can reduce the
appearance of dark silhouettes in a picture.

® WDR: Wide dynamic range. For locations that are strongly lit, this
function reduces brightness levels by adding a dark contrast,
making the image clearer.

® HLC: Highlight compensation. This function can reduce brightness
to help balance lighting in the picture.

Channel Name

Set device channel name. Channel name cannot input null characters.

Step4  (Optional) Configure the Easy Focus function.

(1

Complete this step when you need to make fine adjustments to the focal distance.

1. Click Easy Focus.

Easy Focus

Figure 4-28 Easy focus

1.Minimum focal length

Before adjustment,
manually camera focal
length to min. Make sure
there is no maving object in
front of lens.

2 Max focal length
Click the Sample button,

and adjust focus length to
the max manually.

3.Adjust focal length
Click the Adjust button, and
make the instruction line
into the best area by
adjusting camera focus.

Adjust Stop
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2. Manually adjust the device focal length to the minimum value, and then click
Sampling. Meanwhile, manually adjust the device focal length to the maximum value.

Figure 4-29 Sampling

1.Minimum focal length

Before adjustment,
manually camera focal
length to min. Make sure
there is no maoving objectin
front of lens.

2 Max focal length

Click the Sample button,
and adjust focus length to
the max manually.

3.Adjust focal length
Click the Adjust button, and
make the instruction line

into the best area by
adjusting camera focus.

3. Click Adjust.

The Best Area page is displayed. Manually adjust the focus until the focal length
indicating line is in the best area.

I

® The red line indicates the image definition value, and the green line indicates the
definition value when the focal length changes from minimum to maximum.

® (lick Stop to stop making fine adjustments to the focal distance.

Figure 4-30 Final result

1.Minimum focal length

Before adjustment,
manually camera focal
length to min. Make sure
there is no maving objectin
front of lens.

2 Max focal length

Click the Sample button,
and adjust focus length to
the max manually.

3.Adjust focal length
Click the Adjust button, and
make the instruction line

into the best area by
adjusting camera focus.
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4.6.2.3 Configuring Profile Parameters

You can set the switch methods to let the device switch profiles automatically while working. This
function corresponds to the profile management function of cameras. For more details, see the
user's manual of the camera.

Procedure
Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page”.

Step2 Click the Profile Management tab.
Step3  Configure parameters.
® Select Normal . The device works according to the Normal profile.
® Select Full Time, and then select Day or Night. The device works according to the
Day or Night profile.
Figure 4-31 Full time
Profile Management () MNormal @ FullTime () Schedule
Always Enable Day - Save
® Select Schedule, and then type Day Start Time and Day End time. The rest time is
defined to be night by default. For example, if you set 8:00-17:00 as day, 0:00-8:00 and
18:00-24:00 as night, and the device switches profiles according to the schedule.
Figure 4-32 Schedule
Profile Management () MNormal () FullTime (@ Schedule
Day Start Time 00:00:00 - Save
Day End Time 23:59:59 -

Step4 Click Save to complete settings.
Step5 (Optional) Apply configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration page.

4.6.2.4 Configuring Alarm Tone

Supports uploading alarm tones separately or in batches to video devices.
Background Information

(L1

Only devices with alarm tone function can display this tab.

Procedure
Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
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Step2 Click the Alarm Tone tab.
Step3  Click Select to select the alarm tone from the computer.

Figure 4-33 Select alarm tone

Alarm Tone Select Save

Apply to...

Step4 Click Save to complete settings.
Step5 (Optional) Apply configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#*) will be displayed.

2. Click Return to return to the configuration page.

4.6.2.5 Importing ITC Configuration Files

You can import configuration files to ITC devices. This function is only available on ITC devices.
Procedure

Step1 Double-click a ITC device on the device tree, and then enter the username and password
of the device to log in to the device.

Step2  Click Import ITC Config, and then click Import.
Figure 4-34 Import configuration file

Encode Image Profile Management Import ITC Config

Import ITC Config
Import

Step3  Select the configuration file and then import it to the system.
Step4  (Optional) Apply the configurations to other ITC devices.

1. Click Apply to, and then select ITC devices.
2. Click Configuration.

The configurations will be applied to the selected devices. The success icon (~) will

be displayed if the application is successful; otherwise the failure icon (#+) will be
displayed.

4.6.3 Access Control Devices

For access control devices, you can configure the parameters on the Device Config page, such as
device channel number, card number, TCP port, and bit rate. You can also get system logs and
enable OSDP (Open Supervised Device Protocol) for access control devices.
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4.6.3.1 Configuring Access Control Parameters

Procedure
Step1  Open the Tool, and then select KEEEEEEE,
Step2  Select an access control device in the device list, and then click Get Device Info, or
double-click the device.
Step3  (Optional) If the login dialog box is displayed, enter the username and password for the
device, and click OK.
Step4  Configure access control parameters.
Figure 4-35 Access control config
Access Control Config Metwork
Channel Config
Channel 0 -
Card No -
System Log Get
Card Reader Config
Reader Serial No. 0 -
Bitrate hd
S0P Enable
The page and parameters are for reference only, and might differ from the actual device
type and model.
Table 4-6 Access control parameters description
Parameter Description
Channel Select channel to set the parameters.
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Parameter

Description

Card No.

® Byte Revert: When ACS controller works with third-party readers
(except HID), and the card reading result does not match the sent
card number. For example, the card reading result is hexadecimal
0x 12345678 (decimal 305419896) while the sent card number is
hexadecimal 0 x 78563412 (decimal 2018915346), you can select
Byte Revert to match them.

® HIDpro Convert: When the ACS controller works with HID
readers, and the card reading result does not match the sent card
number, for example, the card reading result is hexadecimal 0 x
12345678 (decimal 305419896) while the sent card number. is
hexadecimal 0 x 78563412 (decimal 2018915346), you can select
HIDpro Revert to match them.

® No Convert: If the system fails to match card reading result with
the sent card No. by operating Byte Revert or HIDpro Convert,
you can select No Convert to restore.

SysLog

Click Get to get device log.

Reader Serial No. Select the reader to set bit rate.

Bitrate

If card reading is slow, you can increase bit rate. It is 9600 by default.

OSDP Enable

When ACS controller works with third-party readers through ODSP
protocol, you can enable ODSP function.

Step5 (Optional) Apply the configuration to other devices.

1.

Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#*) will be displayed.

Click Return to return to the configuration page.

4.6.3.2 Configure Network Parameters

Procedure

wn |\
~ |
D [D
N =

Open the Tool, and then select EEEEESE.

Select an access control device in the device list, and then click Get Device Info, or

double-click the device.

wn
—
1]

w

(Optional) If the login dialog box is displayed, enter your username and password, and

click OK.

wn
—+
o

o

Configure parameters.
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Figure 4-36 Network parameters configuration

Access Control Config Metwork

Network Port Config

Tep Port Save
Register

Hast IP

Host Port 0

DevicelD

Enable Auto Registration

Save

Table 4-7 Network parameters description

Parameter Description
Change TCP port number, and then click Save. When adding the
TCP Port : .
device to the platform, enter this new port number.
Host IP Host IP address configured for auto registration.
Host Port Host Port configured for auto registration.
Device ID Device ID configured for auto registration.

After enabling auto registration, when the device automatically
Enable Auto Registration registers to a server, it will report its current network location to
the designated server for the client software to access the device.

Step5  After the configuration, click Save to send the auto registration parameters to the device.
Step6 (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config.

2. The success icon (+ ) will be displayed if the application is successful; otherwise the
failure icon (#) will be displayed.
3. Click Return to return to the configuration page.

4.6.4 VDP

4.6.4.1 VTO

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2  Configure VTO parameters.
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Figure 4-37 VTO configuration

Device Info
Device Type VTO_DOOR -
Physicsinfo
|:| 0 GrnupCaII
[] 0 Exthumber
WTO Mo. 123456 Center Mumber 588888
SIP Info
Server Type VTO - Register Time &0
Server [P Server Port .
Domain Name YDP Register Pwd LTI
Binitiale Mode
Restart after configuration Save
Audio Info
Audio Type Calling -
Local Upload
Browse Upload
Table 4-8 VTO parameters
Parameter Description
Device Type Select the Device Type from VTO_DOOR and
VTO_WALL.
Building ther the number of the building where the VTO
is installed.
Unit Fnter the number of the unit where the VTO is
installed.
Physicsinfo VTO No. VTO number.
GroupCall When the device acts as' a server, enable or
disable group call function.
ExtNumber Extension number of the VTO.
Center Number Center call number.
Server Type Select the server type.
SIP Info Server |P The IP address of the SIP server.

Domain Name

Domain name of the SIP server.
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Parameter Description

Register Time Register time of the SIP server.
Server Port Port number of the SIP server.
Register PWD Registration password of the SIP server.
Initiale Mode Select the checkbox to enable the server.
Restart after Select the checkbox, and then the device will
configuration restart after configuration.

Step3  Click Save.

Step4  Select the audio type.

Step5 Click Browse to upload the audio file, and then click Upload to upload selected file.

Only files in .mp3 format are supported.

Step6 (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Save. The success icon () will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration page.

4.6.4.2 VTH
4.6.4.2.1 Network Configuration

Procedure

Step1 Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2  Click the Network Config tab, and then configure the parameters.
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Figure 4-38 Network configuration

Metwork Config  MNetwork Terminals

Local Info
Foom 1001#&0
Main IP o . 0 .0

Main User admin

] 55H

SIP Server
Sip Server IP
Sip Register Pwd sessee

Login User admin

Initiale Mode

Password WireZone AlarmMode 3

Main YTH -

Main Password T

Sip Server Port
Sip Realm YDOP

Login Passwaord sssssane

Ok

Apply to..

Table 4-9 Network configuration parameters

Parameter Description
Room Enter the room number.
Enter the IP address of the host.
L]
Main IP ® When selecting Main VTH, you do not need to enter
the main IP, main user, and main password.
Local Info ® \When selecting Sub VTH, you need to enter the main
IP, main user, and main password.
Main User Enter the username of the host.
Main Password Enter the login password of the host.
SSH Select the checkbox to enable SSH authentication to
perform safety management.
Sip Server IP Enter the IP address of the server.
SIP Server Sip Server Port Enter the port number of the SIP server.
Sip Register Pwd Enter registration password of the SIP server.
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Parameter Description
Sip Realm Enter the domain name of the SIP server.
Login User The port username of the SIP server.
Login Password The login password of the SIP server.
Initiale Mode Select the checkbox to enable the server.

Step3  Click OK.
Step4  (Optional) Apply configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration interface.

4.6.4.2.2 Network Terminals

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page”.
Step2  Click the Network Terminals tab, select the main VTO, and then configure parameters.

Figure 4-39 Network Terminals

Metwork Config  Metwork Terminals Password WireZone AlarmMode F

Network Terminals

Main VTO -

Main VTO Name Main VvTO Main VTO IP

Main VTO User admin Main VTO Pwd

[ ] vTO Enable Status Save

Table 4-10 Network terminal parameters

Parameter Description
Main VTO Name Enter the name of the main VTO.
Main VTO IP Enter the IP address of the main VTO.
Main VTO User Enter the username of the main VTO.
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Parameter Description

Main VTO Pwd Enter the password of the main VTO.

VTO Enable Status Select the check box to enable the main VTO.

Step3  Click Save.
Step4  (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration page.

4.6.4.2.3 Password

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2  Click the Password tab, and then enter the new password and confirm password.

(1

The password contains 6 numbers.

Figure 4-40 Password

SinglePoint MetWoaork Termi Passward WireZone AlarmMode 4

Modify User Password

Mew Password [—

poi¥Eakes  Medium Strong

Confirm Password cessns oK

Apply to...

Step3  Click OK.
Step4  (Optional) Apply configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration page.
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4.6.4.2.4 Wire Zone

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2  Click the WireZone tab, and then configure parameters.

Figure 4-41 Wire Zone

SinglePoint MetWork Termi Passward WireZone AlarmMode 2
WireZone
Area Type NO/NC Status En-Delay Ex-Delay
1 IR - | |NOD = | InstantAlarm = - -
2 IR -~ | NO - | | InstantAlarm - - -
3 IR - MO = | InstantAlarm = - -
4 IR - | | NOD = | InstantAlarm = - -
5 IR - | NO = | | InstantAlarm = - -
G IR - | MNO = | InstantAlarm = - -
7 IR - | |NO * | InstantAlarm = - -
3 IR - | MNO = | | InstantAlarm = - -
DK

Apply to...

Table 4-11 Wire zone parameters

Parameter Description
Area The number of the area.
Tvpe You can select the alarm type from IR, Gas Sensor, Smoke Sensor,
yp Urgency Btn, Door Sensor, Stolen Alarm, Perimeter, and Doorbell.

NO/NC Select NO or NC.

You can select the alarm status from Instant Alarm , Delay Alarm,
Status

Bypass, Remove, and 24-hour.

When setting the alarm status to Delay Alarm, you need to set the
En-Delay -

entry delay time.

When setting the alarm status to Delay Alarm, you need to set the
Ex-Delay . .

existing delay time.
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Step3  Click OK.
Step4  (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (v ) will be displayed if the application is
successful; otherwise the failure icon () will be displayed.

2. Click Return to return to the configuration interface.

4.6.4.2.5 Alarm Mode

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2  Click the AlarmMode tab, and then configure the parameters.

Enable or disable areas in different modes.

Figure 4-42 Alarm mode

SinglePoint MetWaork Termi Passward WireZone AlarmMode 3
AlarmMode
Away Stay Sleep Custom
Area \_/n ON Area2 \._/' ON Area3 OFF
Aread \_/' ON Areas OFF Areat \_/u ON
Area’¥ QFF Aread 'x;;' on
oK

Applyto..

Step3  Click OK.
Step4  (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration page.

4.6.4.2.6 Arm

Procedure
Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
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Step2  Click the Arm tab, and then configure parameters.
Figure 4-43 Arming

AlarmiMode Arm Disarm Reserved Info IPClnfo 4
Arm
Arm mode StayMode -

Arm Passward *Please input arm password!

DK

Apply to...

Table 4-12 Arm parameters

Parameter Description

Select the alarm mode from StayMode , Away Mode, SleepMode, and
Arm mode

CustomMode.

Enter the arming password.
Arm password 11

The password contains 6 numbers.

Step3  Click OK.
Step4  (Optional) Apply configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon () will be displayed if the application is
successful; otherwise the failure icon () will be displayed.

2. Click Return to return to the configuration page.

4.6.4.2.7 Disarm

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2 Click the Disarmed tab, and then enter the disarming password.

L1

The password contains 6 numbers.
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Figure 4-44 Disarm

AlarmMode Arm Disarm Reserved Info IPCInfa 1
Disarm
Disarm Password *Pleaze input dizarm password!
0K

Apply ta..

Step3  Click OK.
Step4 (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#*) will be displayed.

2. Click Return to return to the configuration page.

4.6.4.2.8 Reserved Information

Procedure

Step1 Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page”.
Step2 Click the Reserved Info tab, and then enter the reserved email address.

Figure 4-45 Reserved information

AlarmMode Arm Disarm Reserved Info IPCInfo 4

Reserved Information

Reserved Email Save

Apply to..
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Step3 Click Save.
Step4  (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (v ) will be displayed if the application is
successful; otherwise the failure icon () will be displayed.

2. Click Return to return to the configuration page.

4.6.4.2.9 IPC Information

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".

Step2 Click the IPCInfo tab, select the IPC that you want to configure, and then configure other
parameters.

Figure 4-46 IPCl information

AlarmMode Arm Disarm Reserved Info IPCInfa 4

IPC Information

IPCO -
IPC Mame IPCO Stream Type Main Stream -
IPC IP IPC Port 554
IPC User admin IPC Passwaord LTI
ClearAll Save
Table 4-13 IPC Parameters
Parameter Description
IPC Name Enter the name of the IPC.
Select the stream type from Main Stream and Sub Stream
Stream Type . . .
according to the actual situation.
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Parameter Description

IPCIP Enter the IP address of the IPC.

IPC Port Enter the Port number of the IPC.
IPC User Enter the username of the IPC.

IPC Password Enter the login password of the IPC.

Step3  Click Save.
Step4  (Optional) Apply the configuration to other devices.
1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is

successful; otherwise the failure icon (#+) will be displayed.
2. Click Return to return to the configuration page.

4.6.4.3 VTS

Procedure

Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page”.
Step2  Configure VTS parameters.

Figure 4-47 VTS configuration

SIP Info
Server IP
Server Port
Domain Mame VDP
Bcnabie

Add VTO
YTO1 - Unit Door Station -
VTOIP
YTO Mame test
Username admin
Password sanes
Middle Mo, 0oo0s001
[]Enabm

Save
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Table 4-14 VTO parameters

Parameter Description
Server Type Select the server type.
Server IP The IP address of the SIP server.

SIP Info Domain Name The domain name of the SIP server.
Register Time The register time of the SIP server.
Server Port The port number of the SIP server.
Add VTO Click Add VTO to add a new VTO.
VTO No. The added VTO number.
VTO Type Select Unit Door Station or Fence Station.
VTO IP Enter the IP address of VTO.

Add VTO VTO Name Enter the name of VTO.
Username Enter the web login username.
Password Enter the web login password.
e S e
Enable Select the checkbox to enable the server.

Step3  Click Save.

4.6.5 Android Digital Signage

You can configure apps in batches, debug Android, and export logs.

4.6.5.1 Configuring APP

You can change the IP address of APP registration in batches.

Procedure
Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page”.
Step2 Click the App Config tab.
Step3  Enter the IP address in APP IP Config.
Step4  Click Modify.
Figure 4-48 Modify app configuration
Modify App Config
APP IP Config

Modify

Step5  Apply the configuration to other devices.
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1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (v ) will be displayed if the application is
successful; otherwise the failure icon () will be displayed.

2. Click Return to return to the configuration page.

4.6.5.2 Enabling Android Commission

Enable or disable the Android commission function.

Procedure
Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page”.
Step2 Click the Android Debug tab.
Step3  Select On in ADB Enable.
Step4  Click OK.
Figure 4-49 App Commission
ADB Option
ADB Enable @ on O off OK
Step5 (Optional) Apply the configuration to other devices.

1. Click Apply to, select the devices that you need to sync the configured parameters to,
and then click Config. The success icon (~) will be displayed if the application is
successful; otherwise the failure icon (#+) will be displayed.

2. Click Return to return to the configuration page.

4.6.5.3 Exporting Log

You can export the logs of Android digital signage.

Procedure
Step1  Complete Step 1 to Step 3 in "4.6.1 Accessing the Configuration Page".
Step2 Click the Export Log tab.
Step3  Click Select Path to select the export path.
Step4  Click Export Log, and then the exporting progress is displayed.
Figure 4-50 Modify app configuration
Export Log
Export Path Select Path
Progress Update | 0% ' Export Log
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4.6.6 Alarm Host Devices

4.6.6.1 Device Information

You can view the device information on this page.

Figure 4-51 Device information

Device Info Metwork

Features

Mumber of Alarm Inputs
Mumber of Alarm Ouiputs
Version

Hardware Version

SCM Version

Web Version

Security Baseline Version

4.6.6.2 Configuring Network Parameters

Procedure
Step1  Open the Tool, and then select Kk
Step2  Select an alarm host device in the device list, and then click Get Device Info, or double-
click the device.
Step3  (Optional) If the login dialog box is displayed, enter your username and password, and
then click OK.
Step4  Configure parameters.
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Figure 4-52 Network parameters configuration

Drevice Info Metwork

2G/4G

Enable D

Enable Mobile Data D

Metwark Type -

APN

Authentication Type NO_AUTH -

Dial-up Ma.

Username

Password

Refresh
Table 4-15 Network parameters description

Parameter Description
Enable Select the check box to enable 2G/4G network.

Enable Mobile Data

Select the check box to enable cellular data network.

Network Type Select the network type supported by the device.

APN Set the access point name for dial-up Internet access.
Authentication Type Select the authentication type for dial-up Internet access.
Dial-up No. Select the dial-up number for dial-up Internet access.
Username Select the username for dial-up Internet access.
Password Select the password for dial-up Internet access.

Step5 Click Apply to apply the parameters to the device.

4.7 Configuring System Settings

You can configure the settings for system time, restart, restore, device password and video

password.

4.7.1 Timing

You can calibrate the device time on the Time page.

Procedure

Step1  Click System Setting.

54




Figure 4-53 Timing (1)

Sync Time
PC Time 2020-09-03 14:48:14 Sync PC
2020-09-03 o | 2359:50 - Manual Sync
DST
[] DsTEnable
DST Type O] Date O Week
Start Time Jan -1 - | 00:00 .
End Time Feb Rk ~ | 0000 -
Save
Figure 4-54 Timing (2)
NTP
MNTP UTC - (UTC+08:00) Beijing, Chongging, Hong Kong, Urumagi -

[ ] synchronize with NTP

MNTP Server time windows.com
MNTP Port 123 (0~B5535)
Update Period 10 Minutes(0~65535)

Save

Step2 Click” next to the device type, and then select one or multiple devices.
1]

If the device is not in the device list, perform search operation again. For details, see "4.1
Adding Devices".

Step3  Select the time sync method for the device.
® Manual sync: Specify the time, select the time zone, and then click Manual Sync. The
device time will sync with the setting.
® PC Sync: Click Sync PC. The device time will sync with the PC time.
® NTP sync: Select the Synchronize with NTP checkbox, and then set the parameters.
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Table 4-16 NTP Parameters

Parameter Description
NTP Select UTC, and then select a time zone from the drop-down list on the
right.
Enter the IP address or domain name of the corresponding NTP server. The
NTP Sever . .
default NTP server is time.windows.com.
NTP Port Enter the port number of corresponding NTP server.

Update Period

Enter the time interval at which the device synchronizes time with the NTP

server.
Step4  (Optional) Select the DST Enable (Daylight Saving Time) checkbox, and then set the
parameters.
(L1
Implement this step when you use the device in the countries or regions where DST is
used.
Table 4-17 DST Parameters
Parameter Description
DST Type Select Date or Week according to the actual needs.
Start Time
Set the DST start time and end time.
End Time
Step5 Click Save to complete settings.

4.7.2 Rebooting

You can manually or automatically restart the device.

Background Information

Restart will interrupt operations, restart the device when it is idle.

Procedure

Step 1
Step 2

Click sl .
Click the Reboot tab.
Figure 4-55 Restart

Auto Reboot

B Auto Reboot Sunday » | | 00:00 -
Ok Config Search
Step3  Click* next to the device type, and then select one or more devices.
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If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Step4  Select the restart type for the device.

® Config Search: Search for the configuration information of the device. The success icon

(~ ) will be displayed if the search is successful; otherwise the failure icon (#*) will be
displayed.

® Auto reboot : Under Auto Reboot type, select the Auto Reboot checkbox, set the
specific day and time, and then click OK.

The device will restart at the set time.
® Manual reboot : Under Manual Reboot type, click Reboot.

The device restarts immediately.

4.7.3 Restoring

4.7.3.1 Restoring Default Configurations of Device

Background Information
You can restore settings except:

® Network settings such as IP address
® User information

Procedure

Step1  Click & .
Step2 Click the Restore tab.

Figure 4-56 Restore default configurations
Timing Reboot Restore Passward Batch

Restore
Factory Default Default

Step3  Click* next to the device type, and then select one or multiple devices.

[

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Step4  Click Default and click OK to restore default configurations.

The results are displayed next to the device after restoring is completed. Icon (~ ) means
success; icon (#%) means failure and you can click icon to view the details.
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4.7.3.2 Restoring Factory Configurations of Device

You can restore the factory default configurations.

Procedure
Step1 Click K .
Step2  Click the Restore tab.
Figure 4-57 Restore default configurations
Timing Reboot Restare Passward Batch
Restore
Factory Default Default
Step3  Click" next to the device type, and then select one or more devices.
If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".
Step4  Click Factory Default, and then click OK to restore factory configurations.

The results are displayed next to the device after restoring is completed. Icon (~ ) means
success; icon (#*) means failure and you can click icon to view the details.

4.7.3.3 Exporting Configurations

Procedure

v |
~+ |+
Fk
w N

Step 4

Click i .
Click the Restore tab.

Click* next to the device type, and then select one or multiple devices.

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

(Optional) Set Encrypt and Export Config File. under the Config File tab.

® |f you select it, enter the password of the file you want to export. The password is
customized and must be 8 to 32 characters. Fill in this password when importing, or
you will fail to import. Click Export, select saving path, enter the file name, and then

click OK. If the device can encrypt and export, the configurations can be exported
normally.

® |f you do not select it, Click Export, select saving path, enter the file name, and then
click OK.

The results are displayed next to the device after restoring is completed. Icon (~ ) means
success; icon (#*) means failure and you can click icon to view the details.
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Figure 4-58 Encrypt and export config file

Config File

Export ﬂ Encrypt and Export Config File.

Password

Confirm Passs

4.7.3.4 Importing Configurations

Procedure

Step1  Click & .
Click the Restore tab.

Step 2
Step3  Click* next to the device type, and then select one or multiple devices.

If the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

Step4  (Optional) Set Decrypt and Import Config File. under the Config File tab.
® |f you select it, enter the password of the file you want to import. The file must be
encrypted and exported before. The password is the same as the exporting one. Click
Import, click OK on the Notice page, select saving path, enter the file name, and then

click OK to apply the imported configurations to all devices of the same type, same
model and same version.

® |f you do not select it, click Import, click OK on the Notice page, select saving path,
enter the file name, and then click OK to apply the imported configurations to all
devices of the same type, same model and same version.

The results are displayed next to the device after restoring is completed. Icon (~ ) means
success; icon (#+) means failure and you can click the icon to view the details.

Figure 4-59 Decrypt and import config file

Config File
Export D Encrypt and Export Config File.
Impaort B Decrypt and Import Config File.
Password
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4.7.4 Changing Device Password

You can change the device login password.

Procedure

Step1  Click &

Step2  Click the Device Password tab.

Modify Password

Old Password

Mew Password

Weak

Confirm Password

Figure 4-60 Device password

Check

Medium Strong

OK

Step3  Click" next to the device type, and then select one or multiple devices.

(1

If you select multiple devices, the login passwords must be the same.

Step4  Set the password.

Follow the password security level hint to set a new password.

Table 4-18 Password parameters

Parameter

Description

Old Password

Enter the device old password. To make sure that the old password
is entered correctly, you can click Check to verify.

New Password

Set password according to the password strength prompt.

Confirm Password

Confirm the new password.

Step5 Click OK to complete modification.
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4.7.5 Batch Configuration

4.7.5.1 Video Standard

There are two video standards, PAL and NTSC.
Procedure

Step1  Click & .
Step2 Click the Batch tab.

Figure 4-61 Table configuration

Video Standard

Video Standard PAL - Save

Step3  Click* next to the device type, and then select one or multiple devices.

® |f the device is not in the device list, perform search again. For details, see "4.1 Adding
Devices".

® |f you do not know which device the video file is exporting, you can select multiple
devices, and then the system will go through each one until successful.

Step4  Select PAL or NTSC from the Video Standard drop-down list, and then click Save.

The results are displayed next to the device after restoring is completed. Icon (~ ) means
success; icon (#*) means failure and you can click icon to view the details.

4.7.5.2 Table Configuration

The Table Config function enables you to perform some device configurations in batches. This is
applicable when you have a lot of devices to configure. Configurations include modifying IP,
creating and modifying password, upgrading devices, adding allowlist and blocklist, and setting
encoding parameters.

Procedure

Ste|Q 1 Cllck ®  System Setiings .
Step2 Click the Batch Config tab.
Figure 4-62 Table configuration

Table Config
Xz Template Open
Operation Type Batch Modify IP - Caonfig
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® |f the device is not on the device list, perform search again. For details, see "4.1 Adding
Devices".

® |f you do not know which device the video file is exporting, you can select multiple
devices, and then the system will go through each one until successful.

Step3 Inthe Table Config section, click Open to open the template, fill in the sheet(s) as
required, and then save the template locally.

(L1
The Result column of the template displays whether the configuration is successful. You

do not need to enter.

Step4  Select a configuration type from the Operation Type drop-down list, click Config, select
the template you saved, and then click Open.

Figure 4-63 Import template

() Open (=8| [==Sa]
Look in: I—D j_-J JO@@E}
W& My Computer Name &  Size Type Date Modified
8, 244574 . General_...1229 (2) Fi...er 2020/..13:43

. General...0210109 Fi_er 2021/..1347

Files oftype: |*.xlsx | Cancel

Table 4-19 Description of the operation type

Operation Type Description

Batch Modify IP Change passwords in the table in batches.
Generate Password Generate password in batches.

Modify Password Change login password in batches.

Batch Upgrade Update devices in batches.

AllowlistAdd Configure IP addresses in Allowlist in batches.
BlocklistAdd Configure IP addresses in Blocklist in batches.

Configure encoding parameters in batches.
[T

Encode Config L
Only supports H264 or H265, stream and enabling or disabling
intelligent encoding.
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Operation Type Description

Change the VTO password of engineering, duress, unlock and

VTO Password issuing card in batches.

Batch Modify Active

. . Modify the active registration of the devices in batches.
Registration

Step5 Open the template to confirm the result, and then view the Result column.

4.7.6 License

4.7.6.1 Update the Device License

If there is a problem with the device license, you need to update the license. Through this method,
you need to contact technical support to apply for a license through the license application
electronic flow.

Procedure
Step1  Click & g and then select License > General.
Step2  Select one or more devices to be authorized in the device list.
Step3  Click Export to export the device configuration information to the computer.

If the export configuration is successful, ~ is displayed on the right side of the device; if
the export configuration fails, #* is displayed on the right side of the device. Click ' or
to view the detail information.
Step4  Contact your technical support personnel to obtain the license.

License needs to bind the device configuration information. Please provide your device
configuration information when you contact the technical support personnel.

Step5  Export the license to the device.

® (lick Select to select the applied license.
® (lick Import to import the license to the device.

Figure 4-64 Update the device license

License
General Repair
Export Path Export
Impart Path Select Impart
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4.7.6.2 One-click Grant Device License

You can use this method when the company's R&D personnel need to temporarily grant a device
license. Through this method, you can directly grant a license to a device without applying for a
license through the electronic flow. The license validity period is 30 days.

Background Information
1

I

® Only company employees have the permission to perform this operation.
® Perform operations on the Intranet of the company.
® The authorization content is the configuration of the filled P/N.

Procedure
Step1  Click & s and then select License > Repair.
Step2  (Optional) If you have not logged in, click Login , enter the Job Number and the
Password in the pop-up dialog box, and then click OK.
Step3  Select one or more devices to be authorized in the device list.
Step4  Enter the P/N of the device, and then click One-click reset.

If one-click reset is successful, ' is displayed on the right side of the device; if the one-

click reset fails, #- is displayed on the right side of the device. Click ¥ or 4 to view the
detail information.

Figure 4-65 One-click reset
License
General Repair Login

Pir One-click reset

4.7.6.3 Online Upgrade

Procedure

Step1  Click K s, and then select License > Online Upgrade.

Figure 4-66 Online Upgrade

Online Upgrade

Export Info Import

Step2 Click Export Info to export the PC information to a dat file.
Step3  Apply for a license file with the exported dat file.
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Step4  Click Import, select the license file you applied for, and then wait for the activation to
complete.

After the activation is complete, go to the Online Upgrade page to check whether the
online upgrade function is available. For details, see "4.5 Online Upgrade".

4.7.7 LLDP

LLDP is used to get the neighbor information of the devices and discover the network topology.
Procedure

Step1  Select System Settings > LLDP.
Step2 Select devices on the device tree.

Figure 4-67 LLDP

Timing Reboot Restore Passwaord Batch License LLDP
LLDP
[ | Enable LLDP Save

Step3  Enable LLDP function.

L1

If this function is disabled, it will take approximately 2 minutes for the network topology
to update.

Step4  Click Save.
Results

® The device displays /|, which means LLDP is successfully enabled.

® The device displays '+, which means LLDP is failed to enable. You can click this icon to view
failure details.

4.8 Resetting Device Password

You can reset device password.

® The password resetting operation can only be performed to the devices in the same network
segment with the ConfigTool PC. To reset other password on the device, you need to log in with
the admin account.

® You can only reset the password of initialized devices.
® Some devices do not support the password reset function.
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4.8.1 Resetting Password in Batches

Reset password of two or more devices in batches. You can only use the XML method to reset
passwords in batches.

Procedure

Step 4

Click &

Select the devices that need to reset password, click Batch Reset , and then click Agree
and OK.

Export XML.

1. Click BrowsePath to select the save path for the exported XML file.
2. Click Next to export the file.

Use the enterprise email that is officially certified by device manufacturer to send the
ExportFile.xml file to the local technical support, and then get the result.xml file from the
technical support.

Figure 4-68 Reset ExportFile.xml

Reset Password

o

Export XML Import XML Modify Password

Please export the password reset request file first and then send to your local agent, salesperson or technical support.

Export Path: C: m =l n BrowsePath

Step 5

Mext

Import XML.
[L]

If the Reset Password-Import XML page is closed, click Import Result.xml on the Reset
Password page, and then import the result.xml file from the displayed dialogue box.

1. Click Open to import the result.xml file from the save path.
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Figure 4-69 Reset password

Export XML @ importanL Modify Password

Please send the file exported in the previous step to the support_rpwiEe s @ e B Gm emall addre...

2. Click Next to start importing.
After exporting the XML, the Reset Password-Modify Password page is displayed.

Figure 4-70 Reset password-modify password

Export Xhil Import =ML '9' Modify Fassward

Yol have selected 1 device(s)

Mew Password
Wieak Medium Strong
Confirm Password
Use a password that has 8 to 32 characters, it can be a combination of letter(s),

number(s) and symbal{s) with at least twa kinds of them. {(excluding single
guate®, double quated™), caland), semicalan), connection symbal{&)

Back *After vou have set new passwoard, please set passwoard again in"Search Setting”.

Step6  Enter the new password, and then confirm the password.
Step7  Click Finish to start resetting the password.

The result is displayed next to the device after operation is completed. Click the success
icon (+) or click the failure icon (#+) for the details.

4.8.2 Resetting Password of One Device

This operation is only applicable to a single device.
Procedure

Step1  Click &
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Step 2  Select the device that needs to reset the password, and then click Reset.
Step3  Reset password.

® Reset by scanning QR code.

1. Select QR Code from the Reset Mode drop-down list.
2. Perform operations according to the instructions on the interface to obtain the
security code.
3. Enter old password, new password, and confirm password.
® Reset by sending XML file. For details, see "4.8.1 Resetting Password in Batches".

Step4  Click OK to start resetting the password.

The result is displayed next to the device after restoring is completed. Click the success
icon (') or click the failure icon (#+) for the details.

4.9 Building Configuration

You can link building devices with organization nodes and send configurations to the actual VTO or
VTH.

L1

® Building configuration supports two modes: generating configuration and distributing, and
importing configuration and distributing. You can switch the mode on the lower-right corner of
the page.

® The device tree supports viewing by IP and SN. You can switch the display mode through the
drop-down list.

Figure 4-71 Building configuration page

6 o

Diedice Tree Agaacialion List Cagcade Config Do Mot Cazcade - Global Farametars.
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= VTO * O Project20230007 170644
« Mol Associated [0 Fence Station
- P * O3 ﬁ.uuulng
O = [ 1 Unit
= AssOCatled O Unit VTO{Main)
- — GV O Unit VTO{Sub)
« [ 1 Fioor
« [J 1 Room
= DOH-\ 1G-P = [ Vilta Station(Main)
* VTH [ Vitla Stabion{Sub)
w Agtacistad O

]
O Second Confirmation
- G-CA » [ Host

]
= [ 1 Extension
(]
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4.9.1 Generating Configuration and Distributing

4.9.1.1 Configuring Global Parameters

Configure the information of the server, VTO and VTH devices.
Procedure

Step1  Select Building Config > Device Tree.
Step2 Configure device information.

Figure 4-72 Global parameters

Global Parameters

Center Number 888888 Server Type | Express/iDss -
Server Address Server Port =~ 5080
Server Username  admin Server Password = sssss
Sip Domain ~ VDP Registered PWD  sssass
VTO Username  admin VTO Password = ssssssss
VTH Username  admin VTH Password = ssssss

Table 4-20 Global parameters description

Parameters Description
Center Number Enter the center number. It is 888888 by default.
Server Type Select server type. It is Express/DSS by default.
Server Address Enter server address. The default address is 192.168.1.108.
Server Username Enter server username. By default, the username is admin.
Server Password Enter server password.
SIP Domain Enter the SIP domain and registration password. They are VDP
and 123456 by default.
Registered PWD Enter the registered password.
® The username and password are admin and admin123 for
VTO/VTH Username and VTO.
Password ® The username and password are admin and 123456 for

VTH.

Step3  Click Save.
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4.9.1.2 Adding Organization Node

Procedure

Step1  Select Building Config > Device Tree.
Step2 Click Add Node to add building organization node.

Figure 4-73 Add nodes

Organization tree node

B buidng @ unit B Foor

Building  Start Building = 1 Number = 1 [_IFence Station
Unit Start Unit 1 Number = 1 [ JunitvTOMain) [JunitvTo(sub)
Floor Start Floor 1 Number 1

[ Jsecond Confirmation

Room Start Room 1 Number 1 X . ) X .
[Jvina Station(Main) [ villa Station{Sub)

Extension Number 0

[

Enable Building, Unit and Floor when you need to select them.

® When selecting Fence Station, there will be a node under the project.

® When selecting Unit VTO (main) or Unit VTO (sub), there will be a main or sub unit
VTO.

® When the unit is disabled, the VTO will be added under the building. If the building is
disabled, the VTO will be added under the project.

® The maximum number if device nodes allowed is 10,000.

The host is created in the project node by default.

® The villa station is divided into the main villa station and sub villa station, among
which the sub villa station can associate multiple devices.

Step3  Right-click the node to rename, add, delete nodes.
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Figure 4-74 Node operations

Add Mode Delete Mode BatchAssociation ExportMode  ExportAll Nodes Import Mode
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Add Node
Delete Node
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Step4  Click OK.
Related Operations

® Delete nodes

Select the node that you want to delete, and then click Delete Node to delete the node.
® Export nodes

Select the node you want to export, and then click Export Node to export the corresponding
node, or click Export All Node to export all nodes.

® |mport modes

If the node tree is not created, you can click Import Node, and then select the previously
exported node tree file to automatically create the node tree.

4.9.1.3 Configuring Linkage

Link the devices with organization nodes, and then you can check the linkage information sending
status.

Procedure
Step1  Select Building Config > Device Tree.
Step2  Select a cascade mode.

® Do not Cascade: Do not cascade second confirmation station to the main VTH.

® (Cascade Second Confirmation Station: Cascade second confirmation station to main
VTH.

Step3  Select a device from the device tree and a node from the organization nodes tree, and
then click Association.

You can only associate one device with one node to an operation.
Step4  Click Association List, select devices to be sent, and then click Config.

® - means that the linkage sent successfully.

L means that the linkage sent failed. Click # to check for the reasons.
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Figure 4-75 Association list
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4.9.1.4 Linking Devices in Batches

You can link the devices with organization nodes in batches through the template.
Procedure

Step1  Select Building Config > Device Tree.
Step2  Select the nodes to be linked, and then click Export Node.
Step3  Select the exported table destination path, and then click Save.
Step4  Open the table, enter the serial number of each device linking with each node, and then
save the file.
® The entered SN must belong to devices existing under the device tree. Otherwise the
linkage might fail.
® VTH can only link with VTH devices.
Step5 Click Batch Association, and then select the finished table.
Step6 Click Association List, select devices to be sent, and then click Config.
® -/ means that the linkage sent successfully.
L means that the linkage sent failed. Click #* to check for the reasons.
Figure 4-76 Association list
Dievice Tree Asgociation List Export Tahle | Associated - = | Global Parameters Config
u NO. Model Device node Serial No. IP: Port Operate QR code
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4.9.1.5 Exporting Related Information

You can export related information table to your PC.

Procedure
Step1  Select Building Config > Association List.
Step2  Select devices to be exported, and then click Export Table.
Step3  Select storage path, and then click Save.
Step4  Open the table on local, and then you can view the related linkage information.
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4.9.2 Importing Configuration and Distributing

Procedure

wn
~
D
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w

—
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w

Step 4

Ciick IS

Click - on the lower-right corner of the page to switch to importing configuration
mode.

Click Download to download the template file, and then enter configuration information
in the file.

[

Supports setting VTS/VTO/VTH configuration. View details in the download template.
Click Import Table to import the configuration file into the Tool.

L1

If there are uninitialized devices in the file, the tool will automatically initialize them and
assign IP to them.

Figure 4-77 Import configuration file
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Step 5

Select the device to be configured, and then click Config to apply the configurations.

After the configuration is complete, each device displays the corresponding configuration
result, and you can click and view it.
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4.10 CGI Protocol

You can modify device password or other parameters through CGl commands and table. Make sure
that you have the corresponding commands from technical support in advance.

I

Use https protocol when configuring information; otherwise the prompt Operation via http is not
safe will appear.

4,10.1 CGl Command Configuration

Procedure

Steg 1 Click 38  colProtocol .
Step2  Enter the Url path, and then click Config.

1. If “ shows next to the device IP, it means that the configuration failed. You can click
the icon to see details.

Figure 4-78 Error message

Details

IP 17z
Operation Type CGICommands
Operation Result Incorrect username or password.

2. Incorrect username or password means that the username and password you have
entered in Search Settings are different from that of the device.

3. Changein Search Settings to the username and password of the device, and then
configure CGl commands again.

4. When succeeding, ¥ shows next to the device IP.

Figure 4-79 CGl command success

|:| NO. Model P Url Path Operate

] IPC-HDBW1... 172 v nager.cgi Config

4.10.2 Changing CGl Commands in batches

Procedure

Steg 1 Clle 38  colProtocol K

Step2  Select the device that you want to configure in batches, click Batch CGl Commands, and
then enter the Url path.
Step3  Click OK.
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L1

Make sure that the Url paths of selected devices are the same.

Figure 4-80 Batch CGlI commands

Batch CGICommands

Url Path:

Selected number of devices: 2 OK

4.10.3 Table Configuration

Procedure
Step1  Click E .
Step2 Click Open Template, and then enter IP address, port No., username, password, and CGl
commands content.
Step3  Save the template, and then close it.
Figure 4-81 Template
IF Address Port Username Password CGI Cemmands Content protocel (0 - http, 1 - https) Result
adnin a cgi- ] 1 0
adnin - feg! ] - L 0
[l adnin fegi 5 = = 1
Table 4-21 Parameter description of the template
Parameter Description
IP Address
Port
Enter the device IP, port, login username and password.
Username
Password

CGI Commands Content

The command path of the device CGI configuration. Sending
configuration through non-default port is available.

Protocol (0 - http, 1 - https)

Http and https are available.

Result

The result of the CGI command execution.

Return to CGl protocol page, and then click Table Configuration.
Select the completed template, and then click Open to import the template. The devices
in the template will be configured as the template.

After the configuration is completed, the success prompt is displayed. You can check the
result in the template.
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Figure 4-82 Select a template
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5 Help

This chapter introduces how to view the help file, QA file and software version, how to set network
parameters and upgrade parameters.

5.1 Help File

® (lick ¥ at upper-right corner, and then select Help to view the user's manual.

® (lick ¥, and then select QA to view the file on frequently asked questions and the answers.

5.2 Software Version

Click ¥, and then select About to view privacy policy, open source and software version.

Figure 5-1 About

About

ConfigTool

Copyright(C) 2022 All Rights Reserved.

Privacy Policy Open Source  Agreement

5.3 Settings

5.3.1 Configuring Parameters

Configure the mode when logging into the device and the parameters related to upgrading the

device, such as upgrade timeout, update timeout interval, network timeout interval and upgrade
speed.

Procedure

Step1  Click “lonthe upper-right corner of the page, and then click Setting.

Step Configure the mode when logging in to the device and the parameters related to
upgrading the device.

Step Click OK.

N

w
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Figure 5-2 Setting

Login Mode (® Security Mode ()Compatibility Mode
Lpdate Timeout{/Min) 30 (5~30)
Metwark Timeout(/Sec) 30 (5~30)

Upgrade Speed(/Time) @®@1KB ( )116KB

Cutput Log

Juoin Experience Program (:)
Device Online Update (:)

Download Path

ihConfigTool\Diownload

Table 5-1 Setting Parameters

Parameter Description
® Security Mode (default): Log in only with secure authentication
method.
® Compatibility Mode : Try to log in with secure or insecure
authentication method. It has potential risks and is not
Login Mode recommended to be used.

Compatibility mode has potential security risks. It is recommended to
log in with security mode.

Update Timeout (/Min)

The maximum upgrade time for a single device when the device is
upgraded.

When the device upgrade time is longer than the set value, the
system notices that the upgrade failed.
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Parameter Description

The maximum timeout for network connection when the device is

upgraded.
Network Timeout (/Sec)
When the network timeout is longer than the set value, the system

stops upgrading.

Select the loading speed when upgrading.

® |f package < 100 MB, the Tool loads the package 1 KB every time.
The speed cannot be modified.

Upgrade Speed (/Time) ® If package size > 200 MB, the Tool loads the package 16 KB every
time. The speed cannot be modified.

® |f 100 MB < package size < 2 G, the Tool loads the package 1 KB
every time. To speed up the process, you can set the speed to 16
KB every time. For details, see "5.3 Settings".

Output Log

Click to enable the function, and click @ to disable the

Join Experience Program .
function.

Device Online Update

Download Path Select the storage path for the online upgrade package download.

5.3.2 Login Authentication

® Device program version is low. Please upgrade the device or enable [ConfigTool]
Compatibility Mode.

In security mode, there is a Login Failed dialog box if the added device does not support

logging in with security mode.
e

Operate according to the instructions and add the device again, when this hint appears. There
are two methods and you can select from.

¢ We recommended upgrading the device bin which is available to log in by Security Mode. It
can ensure the security of system.

¢ Click ¥, and select Setting, and then switch login mode to Compatibility Mode.

® Device program version is low. Please upgrade the device or enable [ConfigTool]
Compatibility Mode.

Devices searched by network segment can all be successfully searched, regardless of if the
devices support logging in with security mode.

[

Device searching does not trigger device login, and the login authentication is not performed.
The device list is displayed normally.

® |ogin failed. Device program version is low. Please upgrade the device or enable
[ConfigTool] Compatibility Mode.

In security mode, if the operated device does not support logging in with security mode but has

to be upgraded, restarted and so on.
=

Operate according to the instructions and then repeat the failed operations when this hint
appears. There are two methods. You can select one of them.
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¢ Itis recommended to upgrade the device bin which is available to log in by Security Mode. It
can ensure the security of system.

¢ Click ¥, and select Setting, and then switch login mode to Compatibility Mode.
® Compatibility Mode has potential security risks. Continue?

Click ¥, then select Setting , and switch login mode to Compatibility Mode.
Figure 5-3 Switch to compatibility mode (1)

Compatibility Mode has potential
security risks. Continue?

® Compatibility Mode has potential security risks. Security Mode is recommended.

Switch login mode to Compatibility Mode , and click OK to confirm.
L]

Compatibility mode has potential security risks. Think twice before operating.
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Figure 5-4 Switch to compatibility mode (2)

Login Mode ()Security Mode (® Compatibility Mode
Compa Mode has potential secu sks
Security Mode is recommended

pdate Timeout(/Win) 20 (5~30)

Metwork Timeout(fSec) 30 (5~30)

Upgrade Speed(Time) @1KB  )16KB

Cutput Log () Open

Join Experience Program

Download Path »
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Appendix 1 Cybersecurity Recommendations

The necessary measures to ensure the basic cyber security of the platform:

1.

Use Strong Passwords
Please refer to the following suggestions to set passwords:

® The length should not be less than 8 characters.

® |nclude at least two types of characters; character types include upper and lower case letters,
numbers and symbols.

® Do not contain the account name or the account name in reverse order.
® Do not use continuous characters, such as 123, abg, etc.

® Do not use overlapped characters, such as 111, aaa, etc.

Customize the Answer to the Security Question

The security question setting should ensure the difference of answers, choose different
questions and customize different answers (all questions are prohibited from being set to the
same answer) to reduce the risk of security question being guessed or cracked.

Recommendation measures to enhance platform cyber security:

1.

Enable Account Binding IP/MAC

It is recommended to enable the account binding IP/MAC mechanism, and configure the
IP/MAC of the terminal where the commonly used client is located as an allowlist to further
improve access security.

Change Passwords Regularly

We suggest that you change passwords regularly to reduce the risk of being guessed or cracked.
Turn On Account Lock Mechanism

The account lock function is enabled by default at the factory, and it is recommended to keep it
on to protect the security of your account. After the attacker has failed multiple password
attempts, the corresponding account and source IP will be locked.

Reasonable Allocation of Accounts and Permissions

According to business and management needs, reasonably add new users, and reasonably
allocate a minimum set of permissions for them.

Close Non-essential Services and Restrict the Open Form of Essential Services

If not needed, it is recommended to turn off NetBIOS (port 137, 138, 139), SMB (port 445),
remote desktop (port 3389) and other services under Windows, and Telnet (port 23) and SSH
(port 22) under Linux. At the same time, close the database port to the outside or only opentoa
specific IP address, such as MySQL (port 3306), to reduce the risks faced by the platform.

Patch the Operating System/Third Party Components

It is recommended to regularly detect security vulnerabilities in the operating system and third-
party components, and apply official patches in time.
Security Audit

® Check online users: It is recommended to check online users irregularly to identify whether
there are illegal users logging in.

® \/iew the platform log: By viewing the log, you can get the IP information of the attempt to
log in to the platform and the key operation information of the logged-in user.

The Establishment of a Secure Network Environment

In order to better protect the security of the platform and reduce cyber security risks, it is
recommended that:

® Follow the principle of minimization, restrict the ports that the platform maps externally by
firewalls or routers, and only map ports that are necessary for services.
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® Based on actual network requirements, separate networks: if there is no communication
requirement between the two subnets, it is recommended to use VLAN, gatekeeper, etc. to
divide the network to achieve the effect of network isolation.
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